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FlukeView Forms 

Documenting Software 

Introduction 

FlukeView Forms Documenting Software lets you transfer 
data from a supported digital test instrument directly to 
forms on your computer. This automates your 
troubleshooting or recording process, reduces the 
possibility for manual error and allows you to collect, 
organize and display meter data in a format that meets 
your needs. 

Contacting Fluke 

To order accessories, receive assistance, or locate the 
nearest Fluke distributor or Service Center, call: 

 USA:  1-888-99-FLUKE (1-888-993-5853) 
 Canada: 1-800-36 FLUKE (1-800-363-5853) 
 Europe:  +31 402-675-200 
 Japan:  +81-3-3434-0181 
 Singapore:  +65-738-5655 
 Anywhere in the world: +1-425-446-5500 

Address correspondence to: 

 Fluke Corporation  Fluke Europe B.V. 
 P.O. Box 9090   P.O. Box 1186 
 Everett WA 98206-9090 5602 BD Eindhoven 
 USA     The Netherlands 

Visit us on the World Wide Web at:  www.fluke.com  
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FlukeView Forms Documentation 

The following documentation is available for use with 
FlukeView Forms.  

Table 1. Documentation Sources 

Documentation 
Format / Where 

to Find 
Use For 

Users Manual Basic operation 
and overview 

Meter Connection 
Pages 

Step-by-step 
instructions for 
connecting each 
type of meter 

Tutorials 

Adobe Acrobat / 
Available on the 
FlukeView 
Forms CD, and 
installed with the 
software 

Step-by-step 
instructions for 
common tasks 

Online Help Windows Help / 
FlukeView 
Forms Help 
menu 

On-the-spot 
application help 

Technical Notes Adobe Acrobat / 
Available at 
www.fluke.com 

and on the 
FlukeView 
Forms CD 

Detailed 
technical 
information. 

 

FlukeView Features 

Acquires and documents readings from supported digital 
meters through IR or standard serial communications. 

• Displays acquired results in graphs and tables. 

• Allows you to save and print results. 

• Allows you to retrieve and view previously saved 
results. 

• Allows real-time logging directly to a connected PC, 
with meters that support interactive logging. 

• Allows you to transfer collected readings to other PC 
applications. 

• Provides standard form templates to display results 
professionally. 

• Includes FlukeView Forms Designer program for 
creating customized form templates (not included in 
FlukeView Forms Basic). 

FlukeView Forms Basic 

FlukeView Forms Basic is a less customizable version of 
FlukeView Forms, designed to provide only basic data 
communications and display capability. It contains a 
subset of the features provided by the full FlukeView 
Forms product, and can be used with only a limited 
number of standard form templates. 
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Installation  

This section describes how to install FlukeView Forms and 
FlukeView Forms Designer. Also, follow these instructions 
to upgrade from an older version of the software. 

System Requirements 

Operating System: Microsoft ME, Windows NT 4.0, 
Windows 2000, Windows XP or Windows Vista. 

Minimum recommended hardware: Pentium class 
microprocessor, 32 MB RAM, and up to 70 MB hard disk 
space (100 MB to install).  

USB cables are not supported for Microsoft Windows NT 
4.0. An available USB port on the PC is also required. 

Note 

To install the software on Windows NT, Windows 
2000, Windows XP, or Windows Vista, you must 
log in with Administrator privileges. 

Installing FlukeView Forms 

To install FlukeView Forms, please see the printed 
FlukeView Forms Installation Guide. For installation of the 
Fluke USB-IR cable, see the USB-IR Cable Installation 
Instructions. 

Overview of FlukeView Forms 

The Users Manual provides an overview of what you need 
to know to use FlukeView Forms. This includes: 

• Starting FlukeView Forms 

• Selecting a form template 

• Transferring data from the meter to the PC 

• Managing forms to meet your needs 

• Saving and retrieving data 

• Exporting data 

• Managing your database 

• Troubleshooting 

Most users start FlukeView Forms, select a form template, 
connect the meter to the PC, transfer data, add user data, 
and then print and save the form. More advanced users 
might spend time customizing form templates, retrieving 
and exporting data, and managing the database. 
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Figure 1. FlukeView Forms Screen 
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Table 2. Graphic User Interface Components 

No. Description 

 A Active form template. Displays meter data and user-entered data. 

B FlukeView Forms menu.  

C Select a form template drop-down list. Lists all form templates available in the open database. Identifies the active 
template currently being displayed. 

D Saved forms drop-down list. Lists all forms you have saved with the active template. Displays the name of the saved form 
you are viewing, or (untitled) if the form has not been saved. 

E Virtual Meter button. Opens the virtual meter window. The virtual meter displays the active meter readings and copies 
single-readings to the active form. It also lists, summarizes, and exports uploaded data.  

F Designer launches the designer. 

G Get Meter Data button. Uploads data from meter memory and displays it in the active form. 

H Logging button. Begins set up and interactive logging from the meter. Displays logged data on the active form. 

I Find button. Helps you locate forms you have saved previously. 

J Clear, Save or Print the active form. 

K Meter connection icon tells you if a meter is connected and communicating with your FlukeView Forms software. 
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Starting FlukeView Forms 

To start FlukeView Forms: 

1. From the Windows taskbar, select Start, Programs, 
Fluke, then FlukeView Forms. 

2. Click the FlukeView Forms menu item. 

Selecting a Form Template 

FlukeView Forms templates are designed to display data 
in different ways. After you select the appropriate form 
template, it becomes the active form. When you transfer 
meter data, it displays in the active form. 

1. On the File menu, select New Blank Form. 

2. A New Blank Form dialog box appears. Double-click 
a form template name in the Select a form template 
list. 

Note 

If you open a new blank form template, 
FlukeView Forms asks if you want to save any 
changes you have made to the current active 
form.  

FlukeView Forms provides general-purpose form 
templates. See online tutorials for more information on 
customizing form templates. 

Getting Data from the Meter to the PC 

The meter communicates with a PC through a USB or 
serial cable. FlukeView Forms transfers meter data to the 
PC three ways: 

• Upload data from meter memory 

• Interactive logging  

• Single-reading copy to the active form 

The type of meter you have determines which transfer 
methods can be used.  
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How Your Meter Communicates Data 

The following table shows how certain Fluke meters 
communicate data to the PC, as well as the type of data 
readings the meters support. See Logged Readings and 
Display Readings later in this manual for additional details 
about types of readings.  

Connecting the Serial Cable to a PC 

1. Attach the IR cable or standard serial cable to your 
PC. 

2. Attach the other end of the cable to the meter. For 
more details or information on your specific meter, 
see Meter Connection Pages on your CD. 

Changing the Communications Port 

The communications port that FlukeView Forms uses is 
displayed at the bottom right of the FlukeView Forms 
screen. 

To change the communications port: 

1. Open FlukeView Forms. 

2. On the Tools menu, select Options. The Options 
dialog box appears. 

3. Click the Communications tab. 

4. In the Port list, click the communications port you 
want to use. The default communications port for 
FlukeView Forms is COM1. 

Table 3. Meter Communication Styles 

Fluke Meter 
Model 

Uploading 
Interactive 
Logging  

Single-Reading 
Copy to Form 

87 IV / 187  L D 

89 IV / 189 L,D L D 

53 / 54 L,D   

183 / 185 D L D 

287/289 L,D L D 

45 / 8808A / 
8846A 

 L D 

568 D L D 

789  L D 

975 L,D   

1653 D   

1550B D   

‘L’ – Logged Readings / ‘D’ – Display Readings 

Note 

If a meter is not found in Table 3, then refer to 
the meter’s users manual. 
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Logged Readings and Display Readings 

FlukeView Forms deals with two types of meter data, 
logged readings and display readings. Refer to Table 3 to 
determine the type of readings generated by your 
meter(s). 

Logged readings are taken during a logging session. 
There are two ways to generate logged readings: 

• During interactive logging between a meter and a PC 
running FlukeView Forms. 

• Some meters support logging directly to meter 
memory. In this case, logged readings are stored in 
meter memory and uploaded from meter memory to 
FlukeView Forms at a later time. 

Display readings are taken one at a time, as opposed to 
being recorded during a logging session. Display readings 
are transferred to FlukeView Forms two ways: 

• When you upload individually saved readings from 
meter memory. 

• When you perform a single-reading copy to form. 

Note 

Readings stored in meter memory are identified 
variously as saved readings, stored readings or 
memory readings in the meter manuals. 

Logged readings in a logging session always have the 
same units. For example, results are all V ac, all V dc, 
etc. However, display readings may be in different units. 
Display readings are not graphed in FlukeView Forms, 
but logged readings can be. 

Note 

FlukeView Forms treats readings from Fluke 
53/54-II, 975, 983, 568 and 287/289 meters as 
both logged readings and display readings. 

Uploading Data 

If your meter has memory, the meter can record data 
without a PC present and store it in meter memory. 
FlukeView Forms then uploads data from the meter 
memory to the PC. Data storage on the meter is limited 
by the meter memory. 

Meters that support uploading data are listed on Table 3. 
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To upload data: 

1. Start FlukeView Forms. 

2. Select the form template you want to use by opening 
the File menu and selecting New Blank Form. 
Highlight the form template in the New Blank Form 
dialog box and click OK. 

3. Connect the meter to the PC using the IR cable. 

4. Turn the meter on.  

Note 

If your meter has a PC/IR SEND button, you must 
use that button to initiate communication with the PC. 

5. On the Meter menu, select Get Meter Data to upload 
the meter data to the active form. The Get Meter 
Data dialog box appears. In some cases, this step is 
unnecessary. Instead, you are prompted with the Get 
Meter Data dialog box automatically.  

You can also press the Get Meter Data button to 
access the dialog box. 

6. Data readings are copied directly into the active form. 

Interactive Logging 

In interactive logging, readings are logged directly from 
the meter and stored on the PC. This allows FlukeView 
Forms to take advantage of the PC’s larger memory while 
connected to the PC during the logging session. 
However, the meter must support interactive logging and 
be either ac powered or have sufficient battery power to 
run for the length of the logging session. 

Meters that support interactive logging are listed on 
Table 3. 
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To begin interactive logging: 

1. Connect the meter to the PC. 

2. Select the form template you want to use by opening 
the File menu and selecting New Blank Form. 
Highlight the form template in the New Blank Form 
dialog box and click OK. 

3. On the meter, choose the meter function and range 
you want to use to measure the input.  

4. In FlukeView Forms, click the Meter button at the top 
right-hand portion of the toolbar. Use the virtual 
meter to confirm that the meter readings are correct. 

5. From the Meter menu, select Logging. The Logging 
Window appears. You can also press the Logging 
button to access the Logging Window. 

6. Set up your logging session using the Setup tab of 
the Logging Window (or make no changes to 
Setup, and use the default configuration). 

7. Click Start or Stop to start or stop logging. 

The Setup, Schedule and Status tabs of the Logging 
Window display settings for and provide information 
about the logging session. Use them to: 

• Change the default logging settings under Setup. 

• Display Simulation Graph to examine the effects of 
your logging settings on example data. 

• Manually Start and Stop a logging session, or set 
scheduled Start/Stop times for a logging session 
under the Schedule tab. 

• Examine the progress of the active logging session 
under Status. 
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Figure 2. Interval Events and Input Events 
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Event Logging 

During interactive logging, FlukeView Forms compresses 
the input being measured by the meter into a series of 
events. Each event is represented by a sample at the 
start of the event, a duration, starting time, ending time, 
and the highest, lowest and average values detected 
during the event.  The highest (max) and lowest (min) 
readings include the timestamps when each were 
detected. See the Graph View options (right click on the 
graph) to view the samples on the events. 

For a more detailed discussion of all types of events, see 
the FlukeView Technical Notes, available on your CD. 

Each event is stored in an individual logged reading. 

Note 

If your meter supports the display of two 
readings at once, and both are being displayed, 
then both readings may be logged, depending 
on the settings you have selected. 

When you start logging, the meter readings are monitored 
by FlukeView Forms and are classified by event type. The 
two event types you will see most often are: 

• Input events are logged when the input reading 
changes beyond the user-defined input event 
settings. You define, in settings, which readings are 
similar enough to constitute an input event.  

Input events are described as either stable or 
unstable. Stable input events contain readings that 
fall inside the user-defined settings. Unstable input 
events contain readings that fall outside the user-
defined settings. See Figure 2. 

• Interval events are logged when the user-defined 
logging interval has ended. Interval events can be 
thought of as a series of readings divided into 
sections by time. See Figure 2. 
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Input events are useful for detecting anomalies in a group 
of data, when monitoring a process or when 
troubleshooting a problem. Interval events are useful if 
the values you record are fairly stable in nature and your 
main purpose is documentation for record keeping.  

If the values you record are fairly stable, but monitoring 
variance from the norm is critical, recording both interval 
events and input events can be a valuable trouble-
shooting tool. The interval events serve as routine 
documentation, while the input events record any 
significant changes that occur during the intervals. 

By default, FlukeView Forms logs both input and interval 
events. You can view either or both on the form. If you 
decide to record only input events or only interval events, 
you lose this flexibility, but you reduce the number of 
readings you take and save disk space on your PC. 

Note 

See the FlukeView Forms Technical Notes for a 
more comprehensive description of how event 
logging is performed and how to effectively use it 
for your purposes. 

Setting Up Your Logging Session 

From the Meter menu, open the Logging Window. 

From the Logging Window, set up your logging session 
by selecting the Setup tab. You can then customize the 
default logging setup to collect your data. 

Simulation Graph 

Display Simulation Graph lets you view the effects of 
changing the logging settings. It shows how an example 
input is compressed into events with the current logging 
settings. After you change the logging settings and click 
the With Setup Data radio button, the Simulation Graph 
updates to reflect your changes.  
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Click on the << button if you want to change the example 
input data to approximate the inputs you are expecting to 
measure. 

Changing the Logging Interval 

To change the logging interval, open the Logging 
Window, select the Setup tab and make changes in the 
Interval section. Changing the logging interval: 

• Does not usually significantly change a graph of the 
data. A very small interval (10 seconds or less) rarely 
provides more significant data, especially if input 
event data is also being recorded. 

• Does directly impact the number of records stored 
(smaller interval means more records are recorded). 

• Does not change the number of times that FlukeView 
Forms requests readings from the meter. This is an 
internal value based on the type of meter and the 
PC’s CPU speed and current performance. 

Changing the Input Event Settings 

Changing the input event settings allows you to specify 
what changes in the input are significant enough to begin 
a new input event.  

To change event settings, open the Logging Window, 
select the Setup tab and make changes in the Events 
section. 

With Relative Threshold selected under Threshold 
method, you specify a percentage change in the readings 
that begins a new event. Relative thresholds work well 
when signal noise (insignificant changes in the input 
signal) is proportional to the expected signal value.  

With Fixed Threshold selected under Threshold 
method, you specify a fixed-value change in the readings 
(in the units of measure that the meter is using) that 
begins a new event. Fixed thresholds work well when you 
want to capture a significant unit change in the input you 
are measuring. 
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If the meter supports internal event logging, you can 
choose to have the meter perform the input event 
detection. When the meter is performing the input event 
detection, the input change detection is noticeably faster. 

Note 

With the exception of the Fluke 789: If your 
meter supports the display of two readings at 
once, and both are being displayed, you need to 
select whether the input event thresholds are 
applied to the primary or secondary display. 

Viewing the Status of a Logging Session 

Once logging starts, from the Logging Window, select 
the Status tab to watch the current logging session as it 
occurs.  

The Recent Activity Chart graphically displays the most 
recently logged events; the current event is yellow, while 
older events are blue, and eventually scroll off the left 
side of the chart. 

The number of events logged and the current high, low 
and average values for the event in progress are also 
displayed in tabular form.  

The active form also updates when an event closes.  

Single-Reading Copy to Form 

You can capture a single display reading from your meter 
and copy it to a form for printing or saving. This is useful 
when you only need the reading that appears on the 
meter for your records.  

To capture a single reading from your meter, the meter 
must be connected to the PC. You may copy more than 
one reading to the form, but the readings must be copied 
one at a time. 

The most common way to perform a single-reading copy 
to form is to use the virtual meter window. Open the 
virtual meter by clicking the Meter button at the top right-
hand portion of the toolbar. 

Meters that support single-reading copy to form are listed 
in Table 3.
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The drop-down list in the top left corner of the virtual 
meter window gives you several options for viewing data.  

• The Primary/Secondary Readings option gives you 
a small screen that reflects the meter display.  

• The Meter Display option simply gives you a larger-
screen view of this data. Both views allow you to use 
single-reading copy to form. 

To perform a single-reading copy to form: 

1. Make sure the meter is connected to the PC. Check 
the meter-connection icon on the lower-right corner 
of the FlukeView Forms screen or the display on the 
virtual meter. 

2. Open the virtual meter by clicking the Meter button at 
the top right-hand side of the toolbar. 

3. Set the virtual meter view to either 
Primary/Secondary Readings or Meter Display. 

4. When the virtual meter displays a reading you want 
to copy, click on Copy Into Form. 

The reading appears at the bottom of any display reading 
table on the form, or in a testpoint reading form item. 

Data from Multiple Meters on a Single Form 

You can display data from more than one meter on a 
single form. This allows you to compare data collected 
from separate meters or from the same meter at different 
times. 

Use data groups to differentiate between data collected 
from different meters. When you transfer meter data to a 
form, specify the data group to associate with the data: 

• When uploading data from meter memory, select the 
data group on the Get Meter Data dialog box under 
Send data to group. 

• When interactively logging from the meter, select the 
data group on the Logging Window setup screen 
under Log to Data Group. 

• For copying meter data from the virtual meter to the 
active form, you will be prompted for the data group 
to associate with the data. 

Each form item that displays meter data is set to a 
particular data group, and displays the meter data 
corresponding to that data group. (Logged Readings 
Graphs can show data from multiple data groups on the 
same graph.) 
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To display multiple data groups on a form, the form 
template you are using must be enabled for multiple data 
groups. Otherwise, the form can only contain data from a 
single meter. Use FlukeView Forms Designer to enable 
data groups on a form template. 

See the online Tutorial #4, “Multiple Data Groups,” for 
step-by-step instructions on how to use data groups. 

Note 

Multiple data groups are not supported in 
FlukeView Forms Basic form templates. 

Using Forms 

The form is the primary element of FlukeView Forms 
documenting software. Each online form contains form 
items, which display meter data or user-entered data. 

Once you have transferred data from the meter to the 
active form, you can enhance the presentation of data in 
a number of ways. 

Manually Adding User Data 

Most form templates have form items designed for 
information that is manually entered by the user. If you 
place your cursor in a field and the symbol  appears, that 
is a user data field. You can enter comments and 
additional data in these fields.  

To retain user data when adding a new set of meter data: 

1. Press the Clear button. 

2. Choose Meter data only from the Clear Form dialog 
box. 

3. Get the new meter data. 

Formatting Data on an Existing Form 

You can change the way data appears on an existing 
form by altering the graphs and tables.  

To alter graphs or tables, place your cursor inside the 
graph or table and right-click. A menu of options for that 
form item appears.  

For instance, when looking at a graph, you can zoom in or 
out and print or save various views of the graph to suit 
your needs. This lets you highlight relevant data. 

Or, you can select Add a Note from the Edit menu to add 
a “sticky note” to the form. Position it to annotate the data 
being displayed in a graph, a table, etc.; the Note will be 
saved and printed with the form. 

See the online Tutorial #2, “Formatting Meter Data,” for 
step-by-step instructions on how to alter the appearance 
of meter data on a form. 
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Printing a Form 

To print a form: 

1. On the File menu, select Print. You can also use the 
Print button. 

2. Sometimes, there is more meter data than the tables 
on the form can display. Select Print tables at end 
of print job to print all meter data in tabular form 
immediately after the form is printed. 

3. Change printer, print range, or copy settings. 

4. Click OK. 

Saving a Form 

Saving a form stores all data and formatting on the active 
form so that you can view the form at a later time. If you 
do not save the form, all the data on the form is lost when 
you transfer new data from your meter, change the form 
template, or exit FlukeView Forms. 

To save a form, from the menu, select File, then Save. 
You can also use the Save button. Save is disabled if 
there is no new data to save.  

Saved forms are identified by the form template and the 
date and time they were first saved. You can also enter a 
30-character remark to help identify the form. The remark 
is displayed after the date and time in the Saved forms 
list at the top of your screen. See “Finding and Opening 
Saved Forms” in this manual for more information. 

Placing Existing Meter Data in a New Form 

Template 

If the active form contains meter data, you can display the 
same data in a different form template.  

1. Select Copy Form Data from the Edit menu.  

2. Open the Select a form template drop-down list and 
select a different form template. If you haven’t 
already saved the form, a Save dialog box gives you 
the option to save the data in your original form 
template. 

3. A blank form is created from the form template you 
selected. 

4. Select Paste Form Data from the Edit menu. The 
meter data is pasted to the form. 
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Note 

User data must be re-entered when you move 
existing data from one form template to another.  

Display Selected Readings 

Sometimes, you might not want to display or save all of 
the readings you have taken from the meter. The Select 
Readings dialog box allows you to: 

• Delete unnecessary readings from the form. 

• Rearrange the order of display readings on the form. 
If display readings are taken in the wrong order, they 
show up in the wrong order on the display readings 
table and testpoint readings form items. Select 
Readings allows you to correct their order. 

• Combine multiple logged readings into a single 
reading. 

Note 

You cannot edit the actual meter data. You can 
only delete entire readings, or you can change 
the order of readings. 

1. From the menu, select Tools, then Select Readings 
to display the Select Readings tool.  

2. The Select Readings dialog box appears. Click Help 
for instructions on deleting, reordering, or combining 
readings.  

See the online Tutorial #3, “Editing Data,” for further 
instructions on using the Select Readings dialog 
box. 

Finding and Opening Saved Forms 

If you save a form, you can access that form again at a 
later time. 

Opening a Saved Form 

To open a form that you have saved previously: 

1. Open FlukeView Forms. 

2. In the Select a form template drop-down list, select 
the template in which you saved the form. 

3. In the Saved forms drop-down list, browse to the 
form and click to open. 
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